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Chapter 1 Preface  
In our experience of working in corporates, every day there are a lot of projects or tasks assigned to 
employees. Normally, the boss only asks staff to complete the work as soon as possible instead of 
telling staff the exact due date, how to do it or which resources are needed. In addition, in some 
companies, they do not purchase professional project management software. Instead, they only 
use free software or Excel worksheet.  

There is a limit if using free software or basic functions in Excel for managing the project. It has 
fewer functions and may not let you get a beautiful Gantt chart.  

Therefore, we have been trying to develop an outstanding project management model in excel like a 
pro. In recent years, there have been a lot of new excel functions and features released, e.g., 
dynamic array function and power query. We found that right now we do not need to use a great 
amount of VBA macros to design excel models anymore.  

In 2023, we finally finish our first version of this project management model, FanProject. We are 
glad to say that it is very close to being like professional software. The most important part is that it 
is Excel, our best friend at work.  

Hope you have great experience in using FanProject. Please give any of your feedback to us. Let us 
know how can we improve our model in the future. 
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Chapter 2 Starting a New Project 
When opening the file of our product, FanProject.xlsm, the first sheet showing up is the 
sheet(“Gantt chart”). In this sheet, you will see our sample data and its Gantt chart, as in the photo 
below. 

 

 

In this workbook, there are other sheets, including “For User”, “Sample”, “Project_1~X” and 
“data_transition”. The sheet(“For User”) is a blank sheet for users’s own use The sheet(“Sample”) 
is the data table of our sample project. The sheet(“Project_1~X”) are the data tables for users to 
plan their projects. And the last sheet(“data_transition”) kept unhide is just for the performance 
purpose. Users don’t need to edit it. 

 

 

Back to our Gantt chart. Let me hide the columns ‘Assigned’ and ‘%’, then show you how to start a 
new project easily. 

PS I will show you how to adjust the headers of Gantt chart in Chapter 9.  
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Go to sheet(“Project1”), then you will see the data table, as in the photo below. 

 

In this sheet, there are 2 command buttons showing up by default, which are for users to 
create/update chart or reset the data. And there is one command button Catch up on progress 
hiding by default, which we will introduce in Chapter 6. 

 

Before creating the Gantt chart, you need to input your project name in cell B2 and at least one task 
name in cell B11. Let’s leave the other fields blank and create our first Gantt chart. 

. 

 

Click Create/update chart button. Boom, your first Gantt chart shows up. 

 

You can see there are two little bars in the chart. One is the summarized schedule of the project, 
which is Project 1 in this case. The other one is the schedule of the task, which is Task1. 

Both two bars are in the same position, today’s date, and with the same width, a day. That’s 
because we’ve set the default value of the start date as today’s date (Sep. 13th is the date I wrote 
this page) and set the default value of working days as a day. 

Until now, maybe you are still a bit confused about what a Gantt chart really does, so let me take 
another example for you.  
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This time, let’s input 3 tasks for Project 1 and enter their start date and working days as well. 

PS The field ‘End’ with dark green is designed to use formular, so please don’t try to edit this column 
unless you know what its influence is. So do other fields with dark green color. 

 

 

Then click Create/update chart. A more meaningful Gantt chart shows up. 

 

 

Now you might understand better that what is the summarized schedule of Project 1 and what 
does the width of the bar mean in the Gantt chart. 

The width of the bars from Task1~3 means how much time you will take to complete these tasks, 
which is also called duration. And the width of the bar from Project 1 means how much time you 
will take to complete this project, which is 5 days in this case. 

 

Before we introduce the next important part, Progress bar, let’s go deeper into the topic of task 
type.
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Chapter 3 Introduction to Task Type 
In our sample Gantt chart, you can see there are two types of shapes, as in the photo below. 

 

 

Let me introduce what’s the difference between them. We have two task types in our model, which 
includes, 

1.Task :  
This type is for normal tasks that you would take among 1 day or days to complete, e.g. writing a 
contract, designing a product, or manufacturing a product in a factory. 

2.Milestones : 
This type is for events planned to be a significant point in project, e.g. customer signing a contract, 
delivery of material, or a kick-off meeting. Normally, we fix the width of the shape of this type to one 
day. Therefore, users don’t need to enter value in the field ‘Working days’. 

In a professional Gantt chart software, there is another type for describing the summarized 

schedule by using the shape like . However, we only use the shape of the bar, as in the 
photo below. 
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So how to change the task type in our model?  
By default, we group the column ‘Task type’ as not to make users feel too much information when 
they first start learning project planning. 

Let’s open the grouping columns by clicking the icon, as in the photo below. 

  

 

You will see the columns C, F, and G showing up, we first focus on the field ‘Task type’ in the data 
table.  

 

 

In this field, we already prepared a dropdown list for users to select, including task and milestones, 
as in the photo below. 
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By default, the task type is ‘task’. So it is not necessary to edit this field when users need the task 
type . However, we still suggest users shall enter ‘task’ in the field to make it clear. On the other 
hand, users must have to select ‘milestones’ if they need the milestones type. 

 Let’s select ‘task’ for Task1 and Task2 and select ‘milestones’ for Task3. 

 

 

Then click create/update chart to see our Gantt chart. You can see the shapes of Task1 and Task2 
are the task type, while the shape of Task3 is the milestones type. 

 

 

Before finishing this chapter, let me introduce some other fields you might need to use during the 
project. 

 

In cell C2, it’s for you to enter the name of the person responsible for this project. In cell F2, it’s for 
you to describe this project. And regarding the field ‘Assigned’ in the data table, it is for you to enter 
the name of the person responsible for each task. 

 

Until now, we just finished introducing the project planning. In the next chapter, you will learn what 
shall you do when a project begins.
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Chapter 4 What Shall You Do When a Project Begins 

Introduction to Plan bar and Progress bar 
When a project begins, you shall check on the progress very often and update the plan for each 
task, depending on how the project goes. In the Gantt chart, we can understand the progress of 
tasks by using another chart series overlapping the original one. We call it Progress bar and call the 
original chart series Plan bar afterward in this manual. 

 

 

Of course, we have prepared the relevant fields in the data table for you, which we group them by 
default. Let’s open it by clicking the icon, as in the photo below. 

  

 

You will see 5 columns showing up, we first focus on the fields ‘Qty done(Task)’, ‘Achievement rate 
%’, and ‘Milestones done (Y)’ plus the field ‘Total qty (Task)‘ which we have yet to introduce in the 
previous chapter. 
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How to calculate the width of Progress bar in the Gantt chart 
The formula to calculate the width of Progress bar is = [Working days] × [Achievement rate %].  

For example, the working days of Task2 are 2 days, and the achievement rate is 50%, so the width of 
the Progress bar is = 2 days × 50% = 1 day.  

  

 

Users might think it is enough that they only need to update the achievement rate. However, in the 
real world, your boss may ask you how you know the achievement rate? Do you just estimate it or…? 

 

  

One day 
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Therefore, we provide a way to calculate the achievement rate that is to quantify your work.  
The formula of the field ‘Achievement rate %’ is = [Qty done (Task)] / [Total qty (Task)] × 100%. 

For example, if you plan to complete Task1 by 10 steps, entering 10 in the field ‘Total qty (Task)‘. 
And at a certain moment during the project that you have completed 5 steps, entering 5 in the field 
‘Qty done (Task)’. Then the ‘Achievement rate %’ equals to = 5/10 = 50%, as in the photo below. 

 

 

Then click Create/update chart button to see our Gantt chart.  

 

 

If users accidentally type 0 instead of 10 in the field ‘Total qty (Task)‘, an error might occur or you 
might get a wrong achievement rate %. For this reason, we have set up a data validation for this 
situation. For example, if user mistype 0 in the field ‘Total qty (Task)‘ and then enter 5 in the field 
‘Qty done (Task)’, an input error alert will show up, as in the photo below. 

 

When seeing this kind of error alert, please read the message and check relevant fields.  
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How to mark the Milestones chart when it is completed 
 

As we introduce in Chapter 2, milestones type is for events planned to be a significant point in the 
project. So it is no need to enter a value in the field ‘Total qty (Task)’. However, if you want to enter a 
value in the fields ‘Total qty (Task)‘ and ‘Qty done (Task)’, you can do that. It doesn’t affect our 
Gantt chart. 
For example, if you plan to have two materials arriving at the site on Oct. 7, it turns out only one 
material arriving. Then you can input relevant values in these two fields.  

It is easy to mark complete milestones in our model. Users only need to enter “Y” in the field 
‘Milestones done (Y)’. For example, we enter “Y” in the field ‘Milestones done (Y)’ for Task4. 

 

You would notice that the field ‘‘Achievement rate %’ becomes 100%. 

  

Then let’s click Create/update chart button to see our Gantt chart. 

 

 

It already marked the milestones chart completed with a dark green color. 
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Chapter 5 Introduction to Parent Task and Children Task 
In Chater 2, we have introduced the summarized schedule in the Gantt chart, as in the photo below 
(the first row). In professional software of project management, they call it parent task, and call all 
the other tasks under the parent task children task. 

  

Because we have already introduced children task in the previous chapters, let’s jump into the 
topic of the parent task. 

For the parent task, there are also Plan bar and Progress bar. Plan bar means schedule with light 
green color and Progress bar means progress with dark green color. 

In our model, although users do not need to enter data for parent task, it is still a good practice to 
know how it works. By default, we group the data table of the parent task. Let’s open it by clicking 
the icon, as in the photo below. 

 

You will see the rows 4 to 8 showing up and see our parent task data table there. Please don’t edit 
this table unless you know how it works. 

  



 

-  14 - 

1. Plan bar of parent task 
The calculation of the start date and the end date of Plan bar of parent task are intuitive. The start 
date is the smallest date from children tasks. Which formula is = SMALL( Project1[Start], 1) . 

The end date is the largest date from children tasks. Which formula is = LARGE( Project1[End], 1) . 

And the working days of parent task is = [End] – [Start] +1. 

2. Progress bar of parent task 
It is a bit tricky how Progress bar of parent task works. The calculation of the width of Progress bar 
is = [Working days] × [Achievement rate %]. Which is in the same way when calculating the width 
of Progress bar of children task.  

However, the formula of the achievement rate of parent task does not equal to [Qty done (Task)] / 
[Total qty (Task)] as children task does. Instead, its formula is the average of all the children tasks.  
The formula is = AVERAGE(  Project1[Achievement rate %]) . 

But in some case, it does not look intuitive in our Gantt chart by using this formula. For example, if 
we have completed Task1~3 (task type).and have yet to complete Task4 (milestones type), the 
average of Task1~4 is 75%. The width of Progress bar is a bit too short as we already complete 
Task1~3. 

 

 

Because it will not take days to complete a task with milestones type, we shall not take it as a 100% 
denominator in the formula of achievement rate. The correct chart shall be like the photo below. 
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The formula we actually use here is, 

=
𝐴𝑣𝑔. 𝑎𝑐ℎ𝑖𝑒𝑣𝑒𝑚𝑒𝑛𝑡 𝑟𝑎𝑡𝑒 𝑜𝑓 𝑡𝑎𝑠𝑘𝑠 + (𝐴𝑣𝑔. 𝑎𝑐ℎ𝑖𝑒𝑣𝑒𝑚𝑒𝑛𝑡 𝑟𝑎𝑡𝑒 𝑜𝑓 𝑚𝑖𝑙𝑒𝑠𝑡𝑜𝑛𝑒𝑠) × 0.1 

𝑇ℎ𝑒 𝑟𝑜𝑤𝑠 𝑜𝑓 𝑡𝑎𝑠𝑘𝑠 + 𝑡ℎ𝑒 𝑟𝑜𝑤𝑠 𝑜𝑓 𝑚𝑖𝑙𝑒𝑠𝑡𝑜𝑛𝑒𝑠 × 0.1
 

We use a coefficient of 0.1 to decrease the influence of milestones in the formula. 
That is all you need to know about the parent task. 

 

Add description for parent task and children task 
There are fields for users to add description for parent task and children task, as in the photo below. 
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Chapter 6 Introduction to Progress Line and how to Catch 
up on Progress 
Progress line and today line 
By default, we hide the progress line and show the today line, which we use a grey dotted line, in the 
Gantt chart. Users can turn on the progress line by selecting the chart, click the filter icon, check 
the series of ‘ProgressLine’ and click apply, as in the photo below.  

 

 

Click Apply, then you will see there is a dark green line showing up. 

 

 

1 

2 

3 

4 
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We call this line Progress line. Progress line is an auxiliary line to help users understand the 
progress of your project better. The position of each point on the line is decided by today line and 
the achievement rate of each task, which means the position of the endpoint of Progress bar. 

For example, you shall complete 50% of work of Task2 by today but you only complete 30%. Then 
the point on Progress line for Task2 will be at the position of the endpoint of Progress bar. Which 
point is on the left side of the today line, so users can know that they have fallen behind schedule. 

 

 

For another example, you plan to start Task3 on Sep. 20, but you have started earlier and already 
completed 20% of work on Sep.18. Then the point on Progress line for Task3 will be at the position 
of the endpoint of Progress bar. Which point is on the right side of the today line, so users can 
know that they are working ahead of schedule. 

 

 

Regarding to Task1 and Task4, because they are all on schedule. So the points on Progress line for 
them are at the position of the today line. 
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How to catch up on progress with just one click 
We believe that many people in the office do not have so much time to check the achievement rate 
of each task every day. If nothing special happens, it should catch up on progress. Therefore, we 
design a functionality to let users catch up on progress easily with just one click. 

In our data table, after opening the grouping columns from J to S, you can find there is a command 
button Catch up on progress, as in the photo below. Which we are going to use a second later.

 

 

Firstly, let’s see how does this project planning look like by clicking Create/update chart. 
In the Gantt chart, you can find that we shall complete ‘Task1’ and ‘Task2’ and complete 50% of 
‘Task3’ by today.  

 

 

Therefore, if we would like to make our Gantt chart catch on progress, we need to calculate the 
value of the field ‘Qty done (Task)’ plus entering “Y” in the field ‘Milestones done (Y)’ for the 
milestones type.  
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The great news is by using our model, users do not have to worry about this problem anymore. You 
can just click the Catch up on progress button and it will help you fill out these two fields ‘Qty done 
(Task)’ and ‘Milestones done (Y)’, as in the photo below,  

 

 

 

Then let’s click Create/update chart button to see our Gantt chart. Boom, we already caught up on 
progress.  
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Chapter 7 How to Schedule Your Task Which Duration 
Among One Day  
It is common that the duration of the task is more than 1 day. However, there are some kind of tasks 
that it only takes hours to complete. So how to schedule this kind of task in our model? 
By default, we set the format of date to yyyy/mm/dd in the fields ‘Start’ and ‘End’, as in the photo 
below. 

 

 

In Excel, the date & time value of 2023/09/16 is actually 2023/09/16 00:00. If you would like to show 
the format of date in yyyy/mm/dd hh:mm, you can change it in the Number format window, as in the 
photo below.  

  

1 

2 

3 

4 
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After typing the format of date & time you would like, click OK. Then the format has become date & 
time, as in the photo below. 

 

For example, we enter 2023/09/20 08:00 in the field ‘Start’ for Task3, and enter 4 hours in the field 
‘Working days’. But the unit of the field ‘Working days’ is in days, users need to convert hours into 
days which equals to 4/24=1.6667. Otherwise, users can also directly enter the formula ’= 1/6’ in 
the formula bar, as in the photo below. 

 

By the way, be careful of the automatic formula filling down function in Excel table. You can disable 
this function at Excel Options, as in the photo below.  

  

1 2 

3 
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Then let’s click Create/update chart button to see our Gantt chart.  

 

 

You can see that the width of Task3 has become short (4 hours).  

If you feel the width of the bar is too short in the Gantt chart, you can use another functionality in 
our model. In the sheet(“Gantt chart”), there are two command shapes for users to scale up/down 
the time axis of the chart, as in the photo below. 

 

You can click the left side of shapes to scale up the time axis of the chart for checking on the 
progress of Task3. 

 

 

We will explain this functionality in more detail in Chapter 9.
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Chapter 8 How to Mark the Relationship Line Between 
Tasks 
In the professional software of project management, there are 4 relationships between tasks, which 
include, 

1. Start from Start 
2. Start from End 
3. End to Start 
4. End to End 

In our model, we only have one relationship that is Start from End.  
What does this relationship mean? In the photo below, you can see there is a grey line with an arrow 
between Task2 and Task3. 

 

This line means that you can start Task3 only if Task2 is complete. For example, in a project of 
developing product, we must finish the marketing first then start selling the product.  
The purpose of this line is to help users easily know the relationship between tasks and know which 
task needed to be done first.  

Let me explain how to add the relationship line in our model. Back to our data table in Project 1. 
You can see there is a field ‘Task no. depended on’ on the right side of the data table. 

 

It means that which task is the one that current task depends on. In this example, Task2 is the one 
that Task3 depends on. Therefore, you shall enter Task2’s task no. in the cell.  
We have already prepared a dynamic dropdown list for users to select, as in the photo below. 
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For knowing the task’s number of each task, you can find it at the beginning of the data table, as in 
the photo below. 

 

In this example, the task number for Task2 is 1.2 

 

 

Then let’s click Create/update chart button to see our Gantt chart. 

 

 

However, this function is only creating a line between the point of the end date for Task2 and the 
point of the start date for Task3. Therefore, be careful to set the starting date of the task correctly. 
Otherwise, you may get a strange relationship line, as in the photo below. 
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Chapter 9 Everything You Need to Know Regarding the 
Sheet(“Gantt chart”) 
Before introducing how the sheet(“Gantt chart”) works, let’s enter some data in the fields 
‘Responsible by’ and ‘Assigned’, as in the photo below.. 

 

 

Then click Create/update chart button to go back to the sheet(“Gantt chart”). 

 

Add filter 
We first introduce the functionality of the command button Add filter. In our model, it is all about 
querying the data by using Excel FILTER function. The function of the button Add filter is to switch 
the original query to the query which three conditions with AND logic contribute to. The conditions 
include project name, person responsible for, and whether the task be completed or not. 

We have prepared a dropdown list for both fields ‘Project’ and ‘Assigned’ to users, as in the photo 
below. 
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For example, if you select Kelsey Fisher in the field ‘Assigned’ then click the button Add filter, you 
will get a Gantt chart with tasks which Kelsey Fisher is responsible. 

 
 

And if you continue checking the checkbox ‘Display only incomplete tasks’, you will get a Gantt 
chart in which it only shows the incomplete tasks, which Kelsey Fisher is responsible. 

 

 

In addition, the function of the button Create/update chart in the sheet(“Project_1~X”) is like the 
button Add filter. The difference between them is that the process of the macro Create/update 
chart would always first delete the value of the condition ‘Assigned’ and leave the checkbox 
‘Display only incomplete tasks’ in the same condition, then run the remaining macro. 

So if we go back to sheet(“Project_1”) and click the button Create/update chart, you will get a 
Gantt chart in which it only shows the incomplete tasks. 

  



 

-  27 - 

All tasks 
Regarding the button All tasks. As it is called, it shows all the tasks from all the projects in our Gantt 
chart, excluding our sample project.  

The process of the macro All tasks would always first delete the value of the conditions ‘Project’ 
and ‘Assigned’ and leave the checkbox ‘Display only incomplete tasks’ in the same condition, 
then run the remaining macro.  

Because in the moment we only have data in project 1, let’s input some data in project 2 as well. 
Then click the button All tasks. You will see it shows both tasks from project 1 and project 2, as in 
the photo below. 

 

 

Summarize 
Regarding the button Summarize. As it is called, it shows only the parent tasks from all the projects 
in our Gantt chart, excluding our sample project.  

 

The macro of the button Summarize also leaves the checkbox ‘Display only incomplete tasks’ in 
the same condition. 
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Scale up/down the time axis of the Gantt chart 
As we already introduced in Chapter 6, we have prepared two command shapes for users to adjust 
the time axis of the chart, as in the photo below. 

 

 

By clicking the left one of the shapes, it makes the width of time axis bigger, as in the photo below. 

 

 

While the right one makes it smaller, as in the photo below. 

 

 

By the way, it has a limit for users to scale up and down the time axis of the Gantt chart. 
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Change theme color 
This functionality is about changing the theme color of the Gantt chart.   

 

Users can change the fill color of cells ‘Light color’ and ‘Dark color’, and then click the button 
Change theme color. For example, we can change the theme color from green to pink, as in the 
photo below. 

 

 

Week number 
Until now, there are only year, month, and day in the header of our Gantt chart. We also have 
prepared the week number for users, which we group this row by default. Users can open this row 
to see the week number. 

 

 

1 2 

3 
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The week number shows up.  

 

Add 3 days before Start and after End 
By default, we add 3 days at the beginning and at the end in our Gantt chart, as in the photo below.  

 

 

If you don’t like this default setting, you can change it by uncheck the checkbox ‘Add 3 days before 
Start and after End’ at the right side in this sheet. 
 

 

 

Click the button Add filter. Then the 3 days at the beginning and at the end in our Gantt chart have 
been removed, as in the photo below. 

. 
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Add fields in the Gantt chart 
By default, we hide the headings in Excel. Let’s unhide the headings by going to tab View, as in the 
photo below. 

 

Then the headings shows up, you will see there are many grouping columns there. 

 

 

Let’s open them and see what fields we have. 

 

 

We are going to leave this part for users to decide what they need for their report. 
Users can hide or group relevant columns for their needs. The photo below is an example of adding 
the fields ‘Start’ and ‘End’ in our Gantt chart. 
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Change language and format cell 
Because we don’t set up any protection for the sheet(“Gantt chart”), users can change anything 
they want in cells. For example, you can change the language of the headers in Chinese in the Gantt 
chart, as in the photo below. 

 

Or users can adjust the text size and color. 

 

Print Gantt chart 
In Excel, it already has functions for users to print out the report, as in the photo below. 

 

 

For example, if you want to print the area of project 1, you can first select this area then go to tab 
Page Layout -> Print Area -> Set Print Area, as in the photo below. 
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We can also add a header for this report. Go to tab Page Layout -> Print Titles -> Header/Footer. 
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Enter what header you like in the blocks and adjust its format. 

 

Then go to tab File -> Print, to print your report. 
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Chapter 10 Manage Project Budget 
 

It would be wonderful if we could manage the project budget directly in our Gantt chart model. Yes, 
we have it, but there are a thousand ways to manage the budget depending on your needs or your 
company’s culture. Therefore, we just make an example to show you how to leverage this model to 
manage the project budget. 

 

Firstly, let’s think about what does budget means in a project. In a project, there are many kind of 
costs from resources that you would spend on. For example, if you hold a meeting, you may need to 
rent a meeting room and prepare food. The money you are planning to pay is your budget. And a 
meeting room is the resource you need. 

 

In a data model of view, the relationship between budget items and a task is a multiple to one 
relationship. For example, there might be one or more budget items for one task. Therefore, you 
shall not directly enter the budget in the data table of Gantt chart. On the contrary, you should 



 

-  36 - 

create a data table of budget separately. Then in the data table of Gantt chart, we can write a 
formula to group by/ summarize the budget for each task from the data table of budget. 

 

In the data table of Gantt chart, there are two grouping columns by default. Let’s open them by 
clicking the icon, as in the photo below.  

 

Then you will see the two fields ‘Customized 1’ and ‘Customized 2’ showing up.  

 

In the following content, we will use the sheet(“Sample”) to show you how to manage your project 
budget by leveraging these two fields plus the sheet(“For User”).  

The photo below is the data table of budget we made for this example on the sheet(“For User”). You 
will see this table if you purchase the Standard version of our product.  
You can see there are two budget items for Task16 which the total budget is 200 + 130 = 330 dollars. 
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Because we will group by/ summarize the budget items into the data table of Gantt chart afterward, 
be careful you use the complete same name in the fields ‘Project name’, ‘Task name’ and 
‘Assigned’ in this budget table. 

Go back to our sample data table, as in the photo below. In the Task 16 row, the field ‘Customized 
1 (Resources)’ automatically join the names of resource name, and the field ‘Customized 2 
(Budget)’ already summarized the budget from the budget table. 

 

 

By the way, we use TEXTJOIN function in the field ‘Customized 1 (Resources)’ and SUM(FILTER(….)) 
function in the field ‘Customized 2 (Budget)’. However, you can create your formula by yourself. 

You can also create a budget chart and put it next to the Gantt chart, as in the photo below. 

 

For further development of creating charts or managing the budget, please contact us. We will 
answer your questions or provide a quote for you. 


